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Adobe Audition 2021 

5 – Multitrack 
 

So far, we have been editing sounds individually. In many cases it might be necessary to combine 

different sounds to make something new. This is done using Multitrack editing where each different 

sound, or track, can be edited and combined to create a new audio composition. Tracks in Audition 

are very similar to Layers in an image editing application like Adobe Photoshop. 

In Adobe Photoshop you can combine 
various images using layers 

In Audition you can combine various sounds using 
tracks. 

  
 

Multitrack editing is common in working with sound. For example in a recording studio, a song is 

often not recorded in a single recording. Instead a song is often recorded with each part in a 

different recording or track. I.e. Separate tracks for drums, guitar and piano. Separate tracks for each 

singer. This allows a studio engineer to adjust each different part separately so that the best results 

can be achieved. For instance if one singer wasn’t quite loud enough, their volume can be boosted to 

match other singers in the final song. Additionally, various effects can be applied to individual parts 

(such as making a certain singer’s voice sound like it comes more from the left speaker than the 

other singers). 
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The example below shows a single song with each of its parts recorded on different tracks just as it 

would in a recording studio. Notice how each track shows a waveform similar to what you see when 

you edit a track individually. Each track can be changed in a variety of ways without affecting the 

other tracks. For example, if you wanted to take a verse that a vocalist sang at the end of the 

recording and put it at the beginning of the song instead, you could easily re-arrange things until 

you’re happy with the result. 
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Exercise 1. Creating a New Multitrack Session 

When we want to combine or record different sounds as different tracks we create a Multitrack 

Session. A session file allows you to save your arrangement of sound files while you are editing. 

1. Firstly, ensure nothing is currently open by selecting the File menu and then Close all. 

2. From the File menu select New and Multitrack Session or press Ctrl N. 

When you create a session, Audition will create and save a file. So, the session settings need to 

include a file name and location. 

3. Enter settings for your session as shown below. Make sure you select a suitable folder location 

to save your session file in. 

 

A new Multitrack session with empty tracks will be created. 

Tip Beneath your menus are 2 buttons for switching 

between single waveform view and Multitrack view. If 

you don’t already have a Multitrack session open, then 

clicking the Multitrack button will open the New Multitrack Session options for you.  

We’ll start by practicing with our animal sounds. Later on, we’ll work on something a bit more 

practical. 

You can open files in Multitrack view in a variety of ways. 

4. Open your Windows File Explorer (  E )and navigate to the folder where your sample files are 

saved. 
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5. Drag the Cat-meow file on to the Files panel in Audition to open it ready for editing. It will 

appear in the file list along with your session file (you can select more than one file while holding 

the Ctrl key and then drag them together if needed). 

 

6. Now drag the file from the files panel on to one of the empty tracks in Audition. You will now see 

the waveform for that file in that track. 

 

If you want to add a file straight in to Multitrack view you don’t need to open the file first. 

7. From the Multitrack menu select Insert Files. 

8. Browse for the location where your sample files have been saved. 

9. Select the file named Cow and click Open (you can select more than one file from here if 

needed). 

The Cow file will now be in your Files list and will also be added to your Multitrack view. If your cat 

sound was placed on your first track then the Cow sound might have been placed over the top of it. 

Don’t worry. It’s still there. We’ll look at moving sounds in a moment. 

10. Open your Windows File Explorer if it is not still open. 
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11. Drag the Horse-neigh file on to the next empty track in Multitrack view. 

 

Notice that the sound files in each track are shown in a different colour. You can customise those 

colours by right clicking the colour bar to the left of the track. 

 

You might be used to moving things by dragging them. However, if you have the Time 

Selection icon active , dragging on a waveform within a track will select part of the 

track. If you want to move a sound while in time selection mode, you can drag using the 

right mouse button without having to use the move tool. 

12. Drag the Cow sound using your Right mouse button to move it sideways. If it was covering your 

Cat sound you should now be able to see it. 

13. Move the Cow sound so that each of the three sounds is on its own track. 

 

14. Use any of the methods already shown to add the Rooster_crowing sound and the Sheep sound 

so that each is on its own track. 

If Audition warns you that any sounds you are adding have different settings to your session click OK. 
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Exercise 2. Editing a Track in Multitrack 

You should now have 5 tracks that have sounds on them. If you’re brave enough to click the play 

button or press Spacebar now, you’ll hear all 5 animals at once. We’re going to do a little more than 

just thrown the sounds on top of each other though. We’ll start by editing a single track. 

1. Click the small S button next to the track that has the Horse-neigh sound on it. 

 

This will put the track in Solo mode so that when you play the session you will only hears this track 

and not the others. The opposite is the M button which will Mute (silence) this track. 

2. Click play or press Spacebar to hear this track on its own (it might help to press the Home key or 

click the at the start of the track to put the play head at the beginning first). 

There is quite a gap in this sound before the horse starts neighing and even more after the horse 

finishes. We can easily adjust the start and end of the sound clip to trim it. This is an example of  

non-destructive editing. This means that it will affect how it sounds in the session file but will not 

alter the actual Horse-neigh sound file. 

3. Move your mouse to the start of the sound clip until your mouse pointer changes in to a  

shape. 

4. Click and drag to the side until the edge of the clip stops right before the horse begins. 

 

5. Drag the end of the clip so that it ends shortly after the horse finishes neighing. 

 

You can split a sound clip into different clips in Multitrack view. This will allow you to re-arrange how 

that sound plays in this Multitrack session but will not alter the original sound file. You can split a clip 
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in a couple of ways. The resulting clips can be re-arranged on a track or even moved to different 

tracks. 

This clip contains 3 main “neigh” sounds so we’ll split it so that each one is a separate clip. First we’ll 

zoom in on the clip so we can see the separate sounds a little better. 

6. Move your mouse over the clip and hold down Ctrl wile you roll your mouse wheel up or down 

to zoom in or out (rolling the mouse by itself will scroll down the list of tracks). This will zoom in 

with your mouse position becoming the centre of the view. 

Tip You can press the + and – keys as an alternate way to zoom in and out with the play head 

becoming the centre of the view. Just like in 

Waveform view you can also use the Zoom 

Navigator across the top of the Multitrack view.  

7. Practice zooming in and out on the track and then zoom so that the Horse-neigh sound clip fits 

neatly in your view. 

8. Make sure your Time Selection tool is active by clicking the  icon or pressing the letter T. 

9. Click inside the sound clip between the first neigh sound and the second neigh sound. 

 

10. Go to the Clip menu (or right click on the sound clip) and select Split (Ctrl K) to split the clip at 

that position. 

You can also split clips by using the Razor tool. If you have used Adobe Premier for video editing you 

might have used the Razor tool before. 

11. Activate the Razor tool by clicking the icon  or by pressing R key. 

12. With the razor tool active, click between the second and third neigh sound to split the clip at 

that point. 

 

13. Press T to return to Time Selection mode. 

Your clip should now be split in to three segments. 

14. Zoom out slightly so that you have a bit of room on either side of the clip. 

15. Using your right mouse button, drag the middle clip so that it is at the start of the track. 

16. Move the first clip so that is starts right after that. You might notice that Audition helps you snap 

the clip on to the edge of the other clip. 

17. Lastly right-drag the third clip so that it starts right after the other two. 
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You can re-arrange these 3 clips into any order that you like in this session while the original audio 

clip will remain unchanged. 

 

Exercise 3. Volume Adjustments and Fades 

Multitrack view gives some simple ways to control the volume for your sound clips.  

First, we’ll look at some ways to control a clip’s volume. The first way is to adjust the volume for the 

track a clip is on. 

1. To the left of the track with the Horse-neigh sound is a section with various controls for the 

track. One of these is the track name. Click the Track name to edit it. 

 

2. Type Horse as a new track name and press Enter to complete the edit. 

3. Give the other tracks suitable names. 

Below the Track name is the track volume. You can edit the track volume in a few ways.  

• Click on the volume number and type a positive number to increase the volume or a 

negative number to decrease the volume. 

• Move your mouse over the number and drag left or right to change the number. 

• Move your mouse over the volume dial itself and drag your mouse to turn the dial just as 

you would turn a regular volume control dial. 

In many cases however, you don’t want to change the volume of the entire track. You just want to 

change the volume at certain parts of the track. One way you can do this is through fading. 

4. Click on your last horse sound clip to select it. 

While the clip is selected you will see a small, shaded box at the beginning and end of the clip. You 

can drag the one at the start of the clip to adjust the fade-in for the clip while the one at the end of 

the track adjusts the fade-out for the track. In this case we want to adjust the fade out so that 

instead of the sound cutting off at the end of the clip, it will fade smoothly to silence. 

 

Fade in Fade out 
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5. Move your mouse over the fade out marker and drag away from the end of the clip to create a 

fade out. 

 

 

Exercise 4. Volume Envelopes 

If you want your volume changes to be more complex than a simple fade in or out you can use a 

volume envelope. An envelope tells Audition to turn the volume up or down as a track plays. Take a 

look at the example below. The light coloured line is the volume envelope which sets the volume 

levels for the clip. When the envelope is at higher points, the volume is louder. When the envelope is 

lower, the volume for this clip is quieter. 

 

We’ll use a volume envelope to adjust the volume for one of our sounds. 

1. Turn off solo mode for the Horse track and turn on solo mode for the Cow track so that we will 

only be hearing that one. 

 

2. Zoom in so that you have a good view of this clip and play it to hear what it sounds like. 

What if we were driving a car past the cow while it was mooing. It might be less loud as we’re 

approaching, louder when we’re right next to it and quieter again as we get further away. We’ll add 

a volume envelope to support our imagination. 

Our clip already has a volume envelope. Since we haven’t made any changes to it yet it is completely 

flat meaning the volume level will be constant across the whole clip. It normally looks like a light-

coloured line just above the middle of the clip. 
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3. Move your mouse over the volume envelope your mouse pointer will change to a black arrow. 

4. Position your mouse near the part of the clip where the cow’s moo starts (if you wanted you 

could trim the clip before that point as shown earlier). 

 

5. Click to add a marker on the volume envelope. 

6. Drag that marker downward to make the volume quieter at that part of the sound clip. 

 

7. Add another marker near the middle of the envelope and drag it upward to make the volume 

louder at that point. 

8. Add a final marker near the end of the clip and move it downward so that it sounds quieter 

toward the end. 

9. The resulting envelope should look like the example below. Play to hear how it sounds. It might 

be a little harder to see the volume envelope on a channel that is a lighter colour but remember 

you can change the colour of channels if you wish. 
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Exercise 5. Panning 

Panning controls the balance between different audio channels. For example, with stereo sound, 

panning controls how much of the sound comes from the left speaker and how much comes from 

the right speaker. Like volume, panning can be controlled for a whole channel or it can be set across 

a clip using an envelope. 

1. Turn off solo mode for the Cow channel and turn on solo mode for the Rooster channel so that 

we are only hearing that one. 

2. Trim the excess silence from the start of the rooster sound clip as shown earlier and move it to 

the start of the track. 

3. Locate the Stereo Balance setting for the track. 

 

4. Try changing the balance to the left and the right. If you have stereo headphones or speakers, 

play the track to hear how it sounds with the different options. 

5. Set the number back to 0 when done so that it is evenly balance between left and right (you can 

type the number 0 in the box just like you can with volume settings). 

Just like volume we can also use an envelope to make the stereo balance change while the sound is 

playing. Imagine if this rooster was flying past us while it was crowing. That might make the sound 

go from left to right. Let’s see if we can do that with our rooster track. 

6. Find the Pan envelope line. It will look similar to your volume envelope but the colours will be 

different. Also, if you hover your mouse over it, Audition will give a tip to let you know which 

one you’ve found. It will usually be right in the middle unless it’s been changed while the volume 

envelope will usually start a little way above the middle. 

 

You edit a Pan envelope in the same way you edit a volume envelope. 

7. Add a point on the envelope near the start of the clip that is higher up. That will make the sound 

come more from the left at that point. 

8. Add another point near the end that is further to the bottom. That will make the sound come 

more from the right at that point. 

http://www.oneil.com.au/pc/


Adobe Audition 2021  5 – Multitrack 
 

© Steve O’Neil 2021 Page 12 of 17 http://www.oneil.com.au/pc/ 

9. Play to see how it sounds. It should sound like it is to the left at the start, moving across to the 

right as the sound plays. Drive by rooster! 

 

 

Exercise 6. Pitch and Stretch 

In a previous section we were adjusting time and pitch in waveform view. The same can be done in 

Multitrack view. The difference is that like other things we have done in Multitrack view, time and 

pitch changes we make here will affect how the sound plays in the session. But they will not modify 

the sound file that we are using. It is another example of non-destructive editing. 

1. Turn off solo mode for the Rooster channel and turn on solo mode for the Cat channel so that 

the cat is the only sound you will hear. 

Time stretching a clip on Multitrack view can be as simple as dragging the edge of the clip. But first 

we need to enable the option that makes this possible. 

2. Locate the Toggle Global Clip Stretching button  at the top of the Multitrack view and click 

on it to enable it. 

 

3. You will now see a small triangle on each end of your sound clips. Drag the Stretch time marker 

at the end of the cat clip to extend, or stretch, the clip.  

 

The longer you stretch it, the more slowly the sound will play. The shorter you make it, the more 

quickly the sound will play. Try different lengths and play to see how it sounds. 
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4. From the Effects menu select Time and Pitch and then Pitch Shifter. 

5. Adjust the Semi-tones setting to make the sound higher and lower. You can play to see how it 

sounds while the Pitch Shifter options are still open. Again this is non destructive editing. 

 

6. Close the Pitch Shifter options window when you have finished adjusting the pitch. 

 

Exercise 7. Special Effects 

As we have just seen, pitch effects can be applied to a channel.  

1. Make sure the Fx button is selected at the top of the Multitrack view. 

 

The Pitch shifter effect that we have applied will be displayed in the list of effects for this channel. 

The small power button  next to the effect enables and disables it. 

 

Multiple effects can be applied to a channel when needed. We’ll add another one to the Cat channel 

but this time we’ll add it a different way. 

2. The first effect space is already used. Click the small triangle button next to the second effect 

space. This will open a menu of effects. 

 

3. From the menu select Modulation and then Chorus. Let’s make a cat choir. 

4. Try some of the Presets at the top and modify some of the individual options. You can play the 

session while these options are still open to hear the effect of your changes. 

Each of these changes we have made in Multirack view only effect Multitrack view. To demonstrate 

that, we can check one of the sounds in waveform view. 

5. Select the cat-meow sound clip and click the Waveform button beneath the main menu. You can 

also double-click on a clip to see that clip in waveform view. 
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Now that we are in waveform view, play the sound and you will notice that it doesn’t have any of 

the changes that we have made as they are only in Multitrack view. The original file is still the same 

unless we modify it in waveform view. Click the Multitrack button to return to Multitrack view. 

Tip You can also press F12 to switch between Waveform view and Multitrack view. 

6. Save the changes to your Session file (Ctrl S). 

Before moving on, you might want to practice the following with this multitrack session. 

• Change which channels are playing by using the Mute and Solo options.  

• Move clips on channels to change how they line up with clips on other channels. 

• Adjust volume envelopes on different clips to adjust how they overlaps with sounds on 

other channels. 

 

 

Exercise 8. Putting it all Together 

After playing around with animal sounds, we’re going to put all of that in to practice with something 

a little more practical. Remember to play the session as you make changes to hear how the changes 

sound. 

1. From the File menu select Close All to close the Barnyard multitrack session and its associated 

files. 

2. Create a new Multitrack Session (Ctrl N). Use settings like the following, remembering to ensure 

that you have selected a suitable Folder Location to save it in. 

 

3. From the sample files add the Whoosh1 sound in to the first track. 

4. Zoom out so that you can see the whole clip. 

5. Modify the Pan Envelope so that it starts slightly on one side and finishes slightly on the other 

side. 

 
1 From freesound.org 
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6. Add your Microphone Recording file from the previous section (Or if you don’t have your own 

recording then use the Cleanup file). Arrange it so that it starts a little before the Whoosh sound 

finishes. 

 

7. Add the Bensound-Energy2 file to the third track. 

8. Arrange it so that it starts playing after the Whoosh starts playing, but before the voice 

recording starts playing. 

9. Trim the music clip so that it ends a short time after the talking finishes. 

Note There are a couple of ways you could trim this music clip. You could drag the end of the clip 

to shorten it. But since it’s much longer than your other clips you might need to do a lot of 

zooming or sideways scrolling. Alternatively, you could simply split the clip at the desired 

spot. Then select and delete the excess section of the clip. 

10. Add a fade out on the end of the music clip. 

11. Adjust the volume of each channel if needed so that no channel is too loud or quiet compared to 

the other channels. 

 

 
2 From bensound.com 
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Exercise 9. Mixdown 

Once you have combined channels in a suitable way you will likely need to save the result as a single 

file. This can be done by creating a Mixdown. That means taking all of your multitrack editing and 

combining it into a single waveform which can then be saved as a single file. 

1. From the Multitrack menu select Mixdown Session to New File and then select Entire Session. 

All of your editing work will now be combined into a single waveform. 

 

2. Play the new waveform to ensure it sounds as intended. 

Note If any of your channels were muted in the multitrack view then they will not be heard in the 

resulting mixdown either. 

We can now save the new file. 

Lossless vs Lossy file formats 
When saving media such as images and sound, you have a choice between lossless and lossy 

formats. Lossless format means that when you save the file, there is no loss in quality. Examples of 

lossless formats are the BMP format for images or the WAV format for sounds. 

Lossy format means that when you save the file, some data is reduced in order to reduce file size. 

This results in some loss of quality. Examples of lossy formats include the JPEG format for images or 

the MP3 format for sounds. Both are common formats that have a relatively file size and work on a 

wide variety of devices, but are lower quality than the lossless formats. 

When saving sound it is often necessary to use a lossy format like MP3 so that your sound can be 

played on a device (such as a mobile phone) that might not be able to play lossless formats like 

WAV. In some cases you also might need a smaller file size such as if the sound is intended to be 

played over the internet. 
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Usually, it is best to work with lossless formats where possible and save a final copy in a lossless 

format also. Then if needed you can save in a lossy format once you have finished. Since we have 

already demonstrated previously how to save a sound file in a WAV format, this time we will save in 

the common lossy MP3 format. 

3. From the File menu select Save As (Ctrl Shift S). 

4. Change the Format to MP3 Audio. 

 

5. Click the Change button next to Format Settings. These settings allow you to adjust the quality 

levels of the saved file. 

The bitrate determines the quality of the MP3 file. A higher bitrate means a larger file but better 

quality. In this case we’ll set it to the maximum amount. This will create a high quality file that will 

still be a much smaller file size than a lossless format like WAV. 

6. Set the Bitrate to 320 kbps. 

 

7. Click OK to close the MP3 settings. 

8. Enter Audition Intro for the File Name and select a suitable Location to save the file in. 

9. Click OK to complete saving the file. 

10. Press F12 to switch back to the Multitrack view. 

11. Press Ctrl S to save the Multitrack session. 

Tip Before saving your file you might want to add Metadata to the file. This means information 

about the file such as title and date recorded. You can add metadata in waveform view by 

selecting Metadata from the Window menu or pressing Ctrl P. You can then fill in the 

information you need to be stored with the sound file. 
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